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Chapter  1

Inside Revit Structure

The Revit Structure interface is designed to be an easy-to-use, organized presentation of com-
mands and drawing areas. The basic interface is highly configurable and can be adapted to fit 
most working needs that may arise as you interact with the computer in order to create a model. 
Multiple model views can be open at once so that you can see plan, section, elevation, and model 
views of an element side by side in the drawing area at one time.

This chapter will explore the interface and the arrangement of menus, toolbars, tabs, and 
other tools available to you in the Revit Structure workspace. The tools found here will be used 
to model and document your virtual structure, and also help you to achieve a building informa-
tion modeling (BIM) solution for your project.

Underlying the graphical interface is a robust database that coordinates the graphical infor-
mation through the use of a parametric change engine that controls the display of all elements 
in your project. In this way, a change in an element that takes place in a plan or a section view is 
immediately propagated to all views in the project, which in turn save lots of time for you and 
allows you to focus on the design of the structure rather than the busywork of having to edit 
many views in order to correct one element, as occurs in most 2D drafting programs.

To succeed in this venture, you will need to add many tools to your tool chest. Imagine a con-
struction worker who goes to work with only a hammer and a screwdriver. In all likelihood the 
worker will not be able to get much accomplished. So to get started, you need to add the neces-
sary tools to your own tool chest so that you can work effectively in the virtual model-building 
environment.

Once you have learned the basics of the various display and modeling tools available to you 
in Revit Structure, you will be ready to move on to the actual modeling process in the subsequent 
chapters of this book.

In this chapter you will learn to:

Use the graphical user interface•u	

Understand the types of elements in the modeling environment•u	

Create and manage project views•u	

Control the graphical display of elements in a project•u	
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4  | Chapter  1  Inside Revit Structure

Using the Graphical User Interface (GUI)
When you double-click the Revit Structure 2009 icon on your desktop, you open the preview 
dialog box. This dialog box shows projects and families on which you have recently been work-
ing. Click one of the existing file icons to open them, or click New to begin a new project (see 
Figure 1.1). 

If you click New, the New Project dialog box will appear. In that dialog box you either choose to 
create a new project template or use a specific project template. Click OK, and then Revit Structure 
puts you into the main graphical user interface (GUI).

The Revit Structure GUI (see Figure 1.2) is task oriented, with a compact footprint and semi-
rigid structure. The task-oriented layout and grouping of like commands makes project man-
agement and modeling within Revit Structure logical and efficient. The compact footprint of the 
GUI is due in large part to the lack of excessive toolbars and dialog boxes, which tend to clutter 
other platforms. This allows a large area in which to work and view the model. The location and 
size of most GUI components are reset to their defaults when you restart Revit Structure, mak-
ing the interface somewhat rigid with regard to user customization.

The GUI (see Figure 1.2) contains a menu bar, toolbars, Options bar, Type Selector, Design 
bar, Project Browser, drawing area, View Control bar, and a status bar, all described in the fol-
lowing sections.

Figure 1.1 
Opening dialog box 
with graphical file 
display
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Using the Graphical User Interface (GUI) |  5

Menu Bar
The standard Microsoft Windows-based menu bar (see Figure 1.3) is located at the top of the 
GUI and provides direct access to all of the commands and settings available in Revit Structure. 
Commands with defined shortcuts will have the shortcut key shown to the right of the command 
name in the menu.

Toolbars
The default Revit Structure toolbar layout (see Figure 1.4) is located directly below the menu 
bar and houses frequently used commands for file management, view navigation, and element 
modification. Toolbar and text label display is controlled from the menu bar: Window  Toolbars 
or the right-click context menu. Display can also be handled by editing the Revit.ini file, which 
will be discussed in a later chapter. Hiding all of the toolbars will completely remove the toolbar 
area from the interface. To show them again, you will need to go through the menu bar or edit 
the Revit.ini file.

Figure 1.2 
Default GUI with 
its intuitive dis-
play of commands

Figure 1.3 
The menu bar  
is an easy-to-use 
pull-down arrange-
ment of most  
commands.
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6  | Chapter  1  Inside Revit Structure

You can rearrange toolbars by left-click-dragging the divider located at the beginning of each 
toolbar. While toolbar and text label display is stored, the arrangement of the toolbars is not. All 
toolbars set to display will be reset to their default positions when you restart Revit.

Options Bar
The Options bar (see Figure 1.5) is located directly under the toolbars and displays options spe-
cific to the active command or selected element(s). These options can be huge time-savers by 
negating the need to dig through a dialog box or launch another command. Even experienced 
users can increase productivity by keeping a watchful eye on the constantly changing Options 
bar and making use of the controls provided. The location of the Options bar above the display 
area makes it easier for the eyes to notice changes. You do not have to keep glancing up and 
down as much as you do in other applications.

Wish Granted Courtesy of the Options Bar

Both beginner and experienced users of Revit Structure alike have uttered, “I wish Revit Structure 
could…” or “I wish Revit Structure had…” among other colorful expressions. These wishes can often 
be granted by simply looking to the Options bar. The following graphics illustrate the many looks of 
the Options bar during the execution of a single modeling command.

When you first invoke the Slab command, the default placement method is Pick Walls, and the Options 
bar shows various default options, as shown in the following graphic:

If you prefer to place the slab by sketching lines, you select the Lines command and the Options bar 
will change, as shown here:

You finish the slab and select it in plan, and the Options bar now shows editing controls:

As you can see, the Options bar had three radically different configurations, each loaded with context-
specific controls that in many cases cannot be found anywhere else. In most cases, after you initiate a 
command you will want to look to the Options bar.

Figure 1.4 
The toolbars 
contains many 
frequently used 
commands.

Figure 1.5 
Keep an eye on the 
Options bar as its 
commands change.
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Type Selector
The Type Selector (see Figure 1.6) is located on the left end of the Options bar and lists all of the 
types available for a given element that are loaded into your project file. Generally you should 
only load in the types you need to use in order to keep the computer performance from slowing. 
The Load button is located conveniently close to the Type Selector so you can load in more types 
as they are needed.  Why load every type of wide flange steel beam into your project if you only 
need a W12x26 and a W18x40?

The Type Selector is used to select a specific element type for placement. If you highlight an 
element that has been placed in your project, you can then use the Type Selector to identify it or 
change its type—for instance, to change a W12x26 to a W18x40. Within your project views any 
existing beam tag for that member size will automatically change its corresponding value to the 
new type.

Design Bar
The Design bar (see Figure 1.7) is permanently docked along the left side of the GUI and con-
tains commands that are used for modeling, annotating, and viewing. These commands are 
organized into nine task-specific tabs: Basics, View, Architectural, Drafting, Rendering, Site, 
Massing, Modeling, and Construction.  The View, Drafting, and Modeling tabs contain the 
majority of the commands required to create and document a structural model. The Basics tab 
combines the most commonly used commands from these three tabs and is an ideal tab to have 
active for most modeling and annotation tasks.

In addition to the nine tabs, two context-specific tabs (Family and Sketch) will appear and 
remain active for the duration of certain commands. The Family tab is used to create and edit 
in-place and external families. The Sketch tab is used to create and modify a sketch and will be 
displayed on the Design bar when using the Slab or other sketch-based elements. 

Tab display is similar to toolbar display in that it is controlled from the menu bar: by choos-
ing Window  Design Bars or by right-clicking on the Design bar and selecting a tab name from 
the context menu. Tab display can also be handled by editing the Revit.ini file, which will be 
discussed later in Chapter 17. Adjust the width of the Design bar by left-click-dragging the right 
border. Tab display settings are remembered, but the width of the Design bar will be reset to its 
default when you restart Revit Structure. 

Figure 1.6 
The Type Selector
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8  | Chapter  1  Inside Revit Structure

Project Browser 
The Project Browser displays all of the views, families, groups, and Revit Structure links in a 
Windows Explorer–style format, and is located to the right of the Design bar (see Figure 1.8). 
The views in the Project Browser can be sorted, grouped, and filtered in a variety of ways 
depending on how you want to organize your project. The organization will be discussed more 
fully in the next chapter.

Unlike the Design bar, the Project Browser can be docked on the left (its default location), top, 
right, or bottom of the drawing area. You can also undock and resize it by left-click-dragging 
any of its borders to act as a floating dialog box. The Project Browser will return to its default 
location and size once you restart Revit.

Figure 1.7 
The Design bar 
houses tabs that 
organize your com-
mands.
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Using the Graphical User Interface (GUI) |  9

Exercise: Create a New Browser View Type: On Sheets

This exercise will step you through the process of creating a new browser view type. The new browser 
view type will be called On Sheets, and as the name suggests you will only be able to see views in the 
project that are placed on a sheet. While working on a project, numerous working, construction, and 
coordination views are typically created and can clutter the Project Browser, so this view type can be 
quite useful. 

This browser view type will allow you to easily view and work on only the views that are part of your 
construction documents.

	1.	 Start a new project.

	2.	 Select the Views heading in the Project Browser, as shown in this graphic:

Figure 1.8 
Project Browser
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10  | Chapter  1  Inside Revit Structure

	3.	 Click the Element Properties button to the right of the Type Selector, as shown here:

	4.	 From the Type drop-down menu in the Type Properties dialog box, select the Not On Sheets type.

	5.	 Click Duplicate, then type on sheets, as shown below, for the name and click OK to close the Name 
dialog box:

	6.	 Click the Edit button next to the Filter parameter.

	7.	 In the Browser Organization Properties dialog box, you will see that the Filter By drop-down menu 
is already set to Sheet Name, followed by a drop-down menu set to Equal To. 

	8.	 Change the Equal To drop-down menu to Not Equal To, as shown here, and click OK to close the 
dialog box:
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	9.	 Finish by clicking OK to close the Type Properties dialog box. Note that your browser is now sorted 
by your new browser view type as illustrated below:

You can change your browser view type at any time by selecting the Views heading in the Project 
Browser and selecting a different type from the Type Selector. The Revit default browser view type 
is All.

Drawing Area
The drawing area (see Figure 1.9) is where all open views are displayed. Multiple views of sev-
eral projects can be open at one time. Project templates and families can also be open in a single 
session of Revit and displayed in the drawing area. You can arrange all of these open views 
in the drawing area by using the Window menu bar in typical Windows fashion. All the view 
controls you would expect are here, including Tile, Cascade, and Arrange, which perform as you 
would expect.

Figure 1.9 
The drawing area 
contains all your 
open views, which 
can be arranged in 
many ways.
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12  | Chapter  1  Inside Revit Structure

Having many views open at once, though, can lead to a slower program response. The Close 
Hidden Windows command is quite important in managing the performance of Revit, especially 
when you are working on large or complex projects. With one view maximized in the drawing 
area, this command will close all but the last active view of each project, project template, and 
family that is currently open. 

Most views open maximized in Revit regardless of how they are triggered, so it is easy to 
quickly have numerous views of a project open at any given time without noticing it. Since Revit 
updates the display of all open views in real time, you can imagine how this can rapidly become 
a performance issue. Frequent use of this command is highly recommended and is a good can-
didate for addition to your shortcut list.

Presentation GUI

While most will find the default interface more than adequate for daily use, a few simple modifica-
tions can drastically change the look of the GUI to better serve other purposes or user preferences. The 
following graphic shows the interface with the Design bar and toolbars hidden and a floating Project 
Browser. This clean look is great for viewing and working with the model while in meetings with the 
design team and/or clients.
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Nice Postage Stamp Collection

I got a new PC recently and was working on a rather complex healthcare project. Impressed with the 
improvement in performance compared to my previous PC, I had not been paying attention to how 
many views I actually had open. The PC slowed considerably (a several-second pause instead of the 
expected near instantaneous response) while I was attempting a rather routine procedure. It was 
not until I tiled my open views a few commands later that I realized what the problem was: 25 open 
windows! They looked like a bunch of postage stamps.  As I began to use the Close Hidden Windows 
command, as shown in the following graphic, my PC’s performance returned to normal.

View Control Bar
The View Control bar (see Figure 1.10) is located on the bottom left of most views. The controls 
found on the View Control bar are for commonly used view and element display properties. 
Each button expands when you select it and displays several context-specific settings.  There are 
eigh main tabs on the bar:

Scale•u	

Detail Level•u	

Model Graphics Style•u	

Shadows•u	

Crop Entire View On or Off•u	

Crop a View Region•u	

Temporary Hide/Isolate•u	

Reveal Hidden Elements•u	
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Working views can change from minute to minute, for instance as you change between 
coarse and medium detail modes, so it is very convenient to have the View Control bar nearby 
for easy access to the controls.

Status Bar
The status bar is located at the very bottom of the GUI. The text on the left of the status bar will 
do the following:

Display the name of a highlighted element.•u	

Display prompts and/or additional information regarding the active command.•u	

List the available shortcuts that are available for a given sequence of characters, which can •u	

be navigated using the arrow keys.

On the right end of the status bar, you can view the status of your keyboard locks (Caps, 
Num, and Scroll). To the right of this is an element selection counter, which will display the 
number of elements currently selected in the drawing.

The Communication Center is located at the right end of the status bar and can be config-
ured to check for software updates, product support announcements, and other related news at 
intervals defined in its settings. The Communication Center can be opened by double-clicking 
or by right-clicking the icon.  In the Communicaton Center dialog box that is then displayed you 
configure which information channels you want to receive information about, such Articles and 
Tips, and at what interval you wish to update your local workstation with the information.

Shortcuts
Shortcuts are one of the most powerful ways to increase your overall speed and productivity 
when using Revit Structure. Shortcuts enable you to launch commands directly from the draw-
ing area without having to move your cursor. That significantly reduces mouse travel, saving 
time and your wrist. Many shortcuts are already defined, and you can create others for nearly 
all commands found within the menu bar.

Right-Click, or Context, Menu
The right-click, or context, menu provides quick access to useful commands directly related to 
the element or object being highlighted. As previously discussed, right-clicking on GUI objects 
(toolbars and the Design bar) displays a menu that controls how they are displayed: 

Right-clicking in the empty space of a view displays a menu (see Figure 1.11) with view •u	

navigation commands and access to the properties of the view. 

Right-clicking different elements in the model will also display various menus (see •u	

Figures 1.12 and 1.13) with access to element- and view-specific commands and properties.

Figure 1.10 
The View Control 
bar makes it easy 
to control the view 
display.
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Now that you have had a good look at the basic Revit Structure interface and command lay-
out, let us explore the various elements that these commands create and manage in the creation 
of your building project.

Figure 1.11 
View context menu

Figure 1.12 
Framing element 
context menu

Figure 1.13 
Wall element con-
text menu
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